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1    Introduction

This document is a user’s guide for advanced modeling techniques in Thermal Desktop.
It has been developed as a road map instead of an instruction manual. The exception to this
is Section 6, Meshing, which contains the instructions for using TDMesh.

1.1 Purpose

Advanced modeling techniques should be used when:

•   The geometry is complex and cannot be easily modeled with Thermal Desktop 
surfaces and solids

•   Simplification of the geometry to be represented by Thermal Desktop surfaces 
and solids would complicate boundary condition modeling

•   The geometry has been developed in other CAD tools

•   The geometry has been developed in other analysis tools

Using some of the advanced modeling techniques within this manual, such as meshing,
should be considered a “last resort”. Some reasons are: simpler models can be easily checked
by hand calculations; complex models can be difficult to debug; extremely large models,
like many finite element models, can be slow to converge.

1.2 Terminology

Throughout this document, the term “thermal model” is used to represent the geometry-
based definition of nodes and conductors. This use of the term covers surfaces, solids and
elements, with associated nodes, but does not refer to boundary conditions, heat loads or
conductance defined between objects. These latter objects are thoroughly documented in
the Thermal Desktop User’s Manual.

1.3 Scope

This document covers:

•   Creation of thermal models based on geometry that has been created using CAD 
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techniques or imported from external sources; importing finite element nodes and 
elements from other sources is noted, but coverage is brief due to its simplicity.

•   Guidance for creating or importing geometry as a basis of the thermal model.

•   Meshing of CAD geometry using TDMesh.

This document does not cover:

•   Basic use of Thermal Desktop. A thorough understanding of Thermal Desktop 
and basic modeling techniques (as covered in the Thermal Desktop User's Manual) 
is assumed and will not be covered in this document.

•   Application of boundary conditions, heat loads and thermal connections 
between model components. These topics are covered in the Thermal Desktop 
User's Manual.

1.4 Process

The advanced modeling techniques consist of two basic steps: defining the geometry
and building the thermal model. In some situations, importing a mesh or a thermal model
defines the geometry and creates the thermal model; this, of course limits the analyst’s ability
to control the resolution of the model.

The Advanced Modeling Process Map (Figure 1-1) provides an overview of the paths
from geometry to thermal model. To use this map, start from the block describing where
the geometry or mesh has been or will be created and follow the possible paths for trans-
ferring the data to Thermal Desktop where the thermal model can be built (or imported in
the case of finite element meshes).

Defining the geometry is accomplished by creating the geometry in Thermal Desktop,
Autodesk Inventor, or a preferred CAD or CAE tool and importing the geometry, if neces-
sary, into Thermal Desktop. Depending on the control the user has over the format of ge-
ometry coming from another CAD tool, the geometry file may have to be translated into a
format readable by Thermal Desktop. Section 2, Section 3 and Section 4 will provide guid-
ance on defining the geometry.

The thermal model is then created by either snapping Thermal Desktop objects to the
geometry, meshing in another CAE tool, or using the Thermal Desktop mesher. Section 4,
Section 5, and Section 6 will provide guidance for these options, with Section 6 being the
user’s guide for using the Thermal Desktop mesher.
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1.5 Guidance

The key to using the advanced modeling techniques described in this manual and ob-
taining a usable thermal model is planning. As with any analytical task, the analyst must
understand the goal of the analysis, understand the necessary detail of the model, plan the
appropriate path through the process and have a preliminary, simple analysis completed.

Figure 1-1    Advanced Modeling Process Map
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The quickest way to have troubles with a model is to over-build from the start. Including
unnecessary detail (i.e. small features which lead to too many nodes) can slow or stall the
solution, obscure important results or make troubleshooting impossible.

Note: C&R Technologies has created TDMesh as a middle
ground between building models with Thermal Desktop surfaces
and solids and meshing in a dedicated mesher. This tool can be
very useful, but if abused will create models that are difficult to
maintain.
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2    Creating CAD Geometry

This section provides an overview of how to create analytic geometry in AutoCAD and
Autodesk Inventor.1 “Analytic geometry” means thermally-appropriate surfaces and solids,
perhaps suitable for subsequent meshing (Section 6). If a thermal analyst has been supplied
a CAD drawing or structural model, refer instead to Section 3 on how to import such data,
and Section 4 on how to prepare it for thermal modeling tasks.

This section presumes that no such CAD drawing is available, and that one or more parts
must be modeled in 2D and/or 3D, and that the complexity of these parts exceeds the
applicability of the native suite of Thermal Desktop FDM surfaces and solids.

It is not the purpose of this section to provide detailed instructions on 2D and 3D mod-
eling capabilities. Training and reference resources are available elsewhere (some such
references are summarized below). Rather, this chapter seeks to provide initial guidance to
the thermal modeler whose CAD experience is limited.

2.1 AutoCAD

Although both AutoCAD and AutoCAD Mechanical offer nearly the same features,
some of the 3D modeling options are only available as text commands, or in specific toolbars,
in more recent versions of AutoCAD Mechanical. In some cases, the primary menu may be
different: the Draw menu in AutoCAD is Design in AutoCAD Mechanical. Therefore, this
section focuses on AutoCAD. To choose AutoCAD, use the Start->All Programs > Au-
todesk > AutoCAD 2008 to choose AutoCAD 2008 (the exact names and paths will vary
by version year). Or, go to Tools>Options and choose <VANILLA> in the profiles tab.

For simplicity, both profiles are referred to herein as “AutoCAD.”

2.1.1   Capabilities

2.1.1.1   Wireframes

AutoCAD can be used to create various wireframe objects (lines, polylines, arcs, rect-
angles, polygons, circles, etc.). Most of the wireframe objects are accessible under the Draw
menu.

1 Autodesk Inventor is available as part of the “Thermal Desktop with built-in CAD” tool suite. For Thermal Desk-
top users with plug-in versions (with AutoCAD purchased separately), upgrading to the built-in version provides
an economical way to get access to Inventor. As later chapters will show, Inventor can also be used to import
and simplify CAD drawings from third party tools.
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Using the Draw > Modeling menu, these wireframes can be extruded, revolved, lofted,
or swept. If a closed wireframe is used, a solid2 will be created; if an open wireframe is used
a surface will be created. 

Closed, co-planar wireframes (including a set of co-planar wireframes sharing end-
points) may also be converted to “regions” using the region command in the text window
(or the Draw > Region menu option) before either being meshed or performing boolean
operations. Regions are two-dimensional so wireframes must be coplanar.

Similar to regions are planar surfaces. A planar surface may be created using the Draw
> Modeling > Planar Surface menu selection. The user is then queried for two points defining
a ractangle’s origin and diagonal or a closed-loop, planar wireframe.

2.1.1.2   Surfaces, Regions, and Meshes

AutoCAD has three main types of surfaces: surfaces, region, and meshes3. Surfaces may
be three dimensional objects with curvature. Regions must be planar, but may be used in
boolean operation. Meshes are comprised of planar faces and, therefore, can only approxi-
mate curved surfaces.

As described in the previous section, surfaces may be created by extruding, revolving,
lofting or sweeping open wireframes. Surfaces may also be extracted from solids by ex-
ploding the solid.

Regions are created either by using the REGION command and selecting a planar, closed
wireframe or using the BOUNDARY command and selecting an interior point of the region.
The BOUNDARY command will determine all boundaries using any coplanar lines and
curves (including wireframes, surfaces and other regions).

AutoCAD can also be used to create meshed surfaces from multiple lines. Using the
Draw > Modeling > Meshes menu, lines can be used to create revolved meshes, ruled,
meshes, edge meshes, and tabulated meshes. The meshes are described by a matrix of M
by N points that define the verticies of the planar faces. The values of M and N are defined
by the AutoCAD variables SURFTAB1 and SURFTAB2.

Boolean operations can be performed on regions. As an example, the process of making
a plate with a hole in it will be described. First, create a rectangle and a coplanar circle
(coplanar will be the default if the UCS is not changed in between creation of the two
objects). Use the region command to convert both the rectangle and the circle into regions.
Then, type subtract or Modify > Solids Editing > Subtract, choosing the rectangle first as
the “object to subtract from,” and then the circle as the “object to be subtracted.” This
complex region can now be meshed (in 2D), or extruded, lofted, etc. then meshed (in 3D).
Figure 2-1 depicts the region after having been extruded.

2 In some cases, it would be better to leave them as wireframes, convert them into regions, then use the TD op-
tions for extruding or revolving a mesh, as explained in Section 6.3 and Section 6.4. See Section 2.4.2 as an
example.

3 “Meshes” in this instance refers to the method used by AutoCAD to create the surface. Nodes and elements do
not exist at this point.
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Other boolean operations include union (encompass all surfaces or volumes of all se-
lected objects as the new region or solid), and intersect (consider only the common area or
volume as the new region or solid). For example, to make a race-track shape, union a
rectangular region with two circular regions. Figure 2-2 depicts such a race-track, after
having been revolved 20 degrees around an axis parallel to the straight sides.

Figure 2-1    Plate with Hole (subtracted circle), Extruded

Figure 2-2    Rectangle with End Circles, Unioned and Revolved 20 Degrees
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2.1.1.3   Solids

Section 2.1.1.1 described how to create a solid by starting with a wireframe. Solids can
also be created directly using various options under Draw > Modeling, including toroids,
cones, and polysolids (a solid version of a polyline).

Once created by whatever means, solids can be unioned, intersected, or subtracted with
other solids to create unusual shapes.4

One particularly useful command, once a solid is finished, is explode (Modify > Ex-
plode). This command replaces the solid with all the surfaces that it contains. The explode
command can be used to create unusual surfaces (for example, the curved edge of the solid
depicted in Figure 2-2).

2.1.2   Training Resources

Help Menu. Extensive resources are accessible via the Help menu in AutoCAD, in-
cluding manuals, tutorials, “showme” features, and access to various online resources.

Autodesk University (www.autodesk.com/au). An annual user conference is hosted
with extensive training opportunities.

CADTutor Website (www.cadtutor.net). A tutorial site with an extensive user forum.

2.2 Autodesk Inventor

2.2.1   Capabilities

Inventor is not intended for the creation of surfaces, though solids can be imported into
AutoCAD and then exploded. Inventor’s ability to create complex solids, however, greatly
exceeds the AutoCAD capabilities, including parametric modeling. While a CAD-adverse
thermal analyst may be hesitant to take such a step, it only takes a few days of training to
gain access to powerful model building capabilities. (Furthermore, learning a little Inventor
enables the user to modify or defeature CAD drawings imported from third party packages
such as Pro/E or Solidworks, as discussed in Section 4.)

In AutoCAD, objects are created somewhat free-form in 3D space, with little consider-
ation to placing and dimensioning them. Inventor takes a very different approach: it is
essentially a “geometric programming” environment. This means that creating even a simple
object might take a few more steps than in AutoCAD, but as will be seen, these extra steps
enforce consistency and add the structure necessary to enable tremendous power.

For example, to create a solid in Inventor, a sketch must first be made on a work plane,
then this sketch must be consumed within an operation such as “extrude” or “loft.” An
update process is available: a change to the underlying sketch will propagate to the higher-

4 Caution: If not done carefully, and sometimes even with suitable care, slivers and other defects (Section 6.2.3)
can arise. For truly complex solids, consider using Inventor instead.
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level operation (e.g., extrude). Such operations are nested and hierarchically ordered, with
dimensions applied along the way. These dimensions can be entered parametrically (like
Thermal Desktop symbols or SINDA/FLUINT registers). Changes to these parameters prop-
agate through the part according to the dimensioning rules developed by the user during the
construction of the part.

Examples of Inventor usage are provided in Section 2.4, and the corresponding files are
available for inspection.

2.2.2   Resources

Help Menu. Extensive resources are accessible via the Help menu in Inventor, including
manuals, tutorials, “showme” features, and access to various online resources.

Autodesk University (www.autodesk.com/au). An annual user conference is hosted
with extensive training opportunities.

CD-based Training. Accelerated Productivity (www.trainingtutorial.com) offers a Sol-
id Modeling self-guided training course for a modest fee that explains the basics of creating
Inventor parts.

2.3 Summary of AutoCAD vs. Inventor

AutoCAD’s heritage as a drafting tool means that it focuses on 2D objects and repre-
sentations. Nonetheless, for simple 3D objects (e.g., a plate with a hole in it), there are
advantages to using it rather than Inventor: Thermal Desktop is only available inside of
AutoCAD and not Inventor.

Inventor provides powerful tools for generating and updating complex 3D parts, but of
course any parts generated in Inventor must be exported to AutoCAD (usually as SAT files),
and that means any assignment of mesh and thermal properties must be repeated if the import
is repeated.

In summary:

1. If the desired object is a surface, use AutoCAD.

Surfaces suffice in many cases for thin objects, and are in many ways superior to sol-
ids since they are computationally more efficient (see for example Section 2.4.1). 
Recall that a virtual thickness, insulation, etc. can be added to Thermal Desktop sur-
faces, and that surfaces can be extruded, rotated, etc. into 3D objects or meshes, and 
symmetry options might then be exploited to further reduce model size.

2. If the desired object is a complex solid, use Inventor (especially if the dimensions are 
subject to change during design iterations).

Each time dimensions change, the Inventor part must be reimported. This means that 
mesh controls and thermal properties and boundary conditions must be reapplied.5 
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This requirement to repeat set-up steps is also present for complex AutoCAD solids, 
so it does not represent a net defect for the Inventor pathway. But it can be difficult to 
change dimensions of a complex (e.g., boolean operated) part in AutoCAD, often 
requiring starting over of the part itself (much less the thermal attributes). This diffi-
culty is not present in Inventor, which accommodates even significant changes to a 
part with minimal rework.

3. If the desired object is a simple solid, consider AutoCAD but Inventor may be applica-
ble as well.

For simple solids, a change to the solid might be made in AutoCAD without losing any 
associated Mesh Controller data (though the user must force a re-mesh). For example, 
the extrude and rotate operations for the objects in Figure 2-1 and Figure 2-2, respec-
tively, can be adjusted using grip points after the mesh has been made. However, the 
size of the hole in Figure 2-1cannot be easily adjusted after the boolean subtract oper-
ation has been performed, whereas the equivalent change is trivial within Inventor. Of 
course, if the solid can be described by a Thermal Desktop solid, then the functionality 
of those will most likely benefit the thermal analysis.

2.4 Example Cases

This section uses specially designed examples to identify important modeling techniques
and to underline key decisions. The AutoCAD drawing files and Inventor part files corre-
sponding to these examples are available for inspection.6

2.4.1   Example: Electronic Equipment Enclosure

A box containing the switch control for a railway is to be stationed outside, and will be
sealed against the environment to minimize maintenance, despite the dissipations of the
internal electronics. When placed in a location in the northern hemisphere, the north side
of the box will be the coldest since it will always be shaded. This fact will be exploited to
keep the electronics inside from overheating in summer. Selective use of paint will be made
on each side, plus a rack of vertical cooling fins (not shown) will be attached on the northern
side.

The box is constructed by stamping a single sheet of aluminum, as shown in Figure 2-
3. A gasket under the bottom flange forms a seal with a foundation plate (not shown). This
gasket is a thermal insulator. A thermal model of the box is desired that can predict the solar
heat loading and infrared and convective heat rejection, including estimation of the gradients
within the conductive surface.

5 Future versions of Thermal Desktop are expected to eliminate this difficulty, in the same way that the centerline
of a FloCAD pipe can be re-assigned without losing the pipe data.

6 Since the focus is on geometric model construction, the drawing files do not represent full Thermal Desktop
models, but rather starting points from which a full thermal/fluid model could be constructed.
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If a CAD drawing of the box were available as shown in Figure 2-3, or if it could be
made quickly by the thermal analyst using Inventor, then it could be imported into AutoCAD
and meshed. For an imported drawing, the bolt holes should be deleted or suppressed as
thermally unnecessary detail, and they should not be constructed by the thermal analyst
using Inventor. Also, the fillets should be removed or suppressed since they are thermally
negligible, and will otherwise cause increased mesh density as the mesher struggles to
maintain geometric fidelity.

Even with these corrections, direct meshing of the de-featured enclosure as a solid
(Figure 2-4) would still be inadvisable for more subtle reasons explained next.

Treating thin objects as solids instead of surfaces can cause undesirable mesh densities
when the part is meshed. An exaggeration of this effect is presented in Figure 2-5. In the
top part of the figure, the mesh generated to represent a thin solid plate contains many small
elements at the edges: the small characteristic dimension of that thickness has caused the
local cell size to shrink at the edge.

In bottom part of Figure 2-5, the surface has been meshed instead (perhaps after ex-
ploding the solid). This 2D mesh can be assigned a virtual thickness within the TD surface
edit form, but if a geometrically faithful thickness is required (perhaps for contact, radiation
leakage, etc.), then the 2D mesh can be extruded (Section 6.3). (Nonplanar surfaces can also
be extruded along local surface normals.) If the thickness is large enough (or if the conduc-
tivity low enough), several 2D mesh layers can be used. If instead the thickness is small

Figure 2-3    Stamped Aluminum Box for Switching Electronics
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enough (or conductivity high enough), these layers can contain the same node numbers
when the TDmesh Extrude option is used, resulting in a model which is geometrically
faithful but thermally approximate.

If a CAD model had been imported (from, say Pro/E or Solidworks) and the holes and
fillets removed, then a further step would still be necessary after importing into AutoCAD:
exploding the box to yield the surfaces on the solid. These surfaces would then form the
basis of the model, using any of the techniques listed in the last paragraph.

For the current model of the electronics enclosure, the use of relatively thick, conductive
aluminum means that there is no need to include temperature gradients in the thickness
direction. Also, there is no need to represent the thickness geometrically. Instead, simple
2D Thermal Desktop surfaces will suffice, as long as the nodes along the edges can be
mathematically welded: made coincident then merged.7

There is little benefit, therefore, in starting with an Inventor part drawing: an AutoCAD
surface-based model is best. In fact, the sides and top of the box can be represented using
Thermal Desktop FDM rectangles with edge nodes (for ease of merging shared nodes with
adjacent rectangles). The top and sides of the box are therefore constructed using FDM
rectangles.

The bolt flange itself could also be constructed with such FDM methods. However, such
a choice would require setting the resolutions (i.e., node locations) with extreme care, such
that adjacent nodes are coincident for both the side walls and the corners.

7 When the material is continuous, merging shared nodes is preferred. Using a high value of contact conductance
is a poor alternative: it leads to both inaccuracies and numerical inefficiencies.

Figure 2-4    Stamped Aluminum Box: De-featured, but Still a Solid Model
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Therefore, TDMesh will be used instead to create a FEM model of the flange. A outer
rectangular region is subtracted from an inner rectangular region in AutoCAD, then meshed.
As experimentation will reveal, the mesher creates an even spacing of nodes on the inner
periphery of such a region, even if it’s not square, and even if the mesh resolution is increased,
etc. This fact means that coincident nodes are available to merge with those on the edges of
the FDM surfaces.

The finished model is depicted in Figure 2-6. The default mesher resolution results in
an 8x8 grid of element lengths along the insides of the flange region, with 9 nodes at the
endpoints of each equally-spaced segment. This means the side panels (represented by TD
FDM rectangles) can be chosen to use a node resolution of 9 using edge nodes, such that
the nodes along the inner periphery of the flange are coincident with the nodes at the bottom
edges of the side panels: they can be merged. Those “shared” nodes will participate both as
members of finite elements and as locations within a finite difference grid.8 The number of
nodes representing the height of the box need not be 9, as long as all sides use the same

Figure 2-5    Meshing a Thin Solid (top) versus Meshing a Surface (bottom)
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value such that nodes can also be merged along the vertical edges. The top panel’s resolution
is then chosen such that its nodes also match those of the top-most edges of the side panels,
such that those nodes are also coincident and can be merged. Once all the merging has taking
place, any adjustments to the mesh density or to the resolution of any of the side panels will
require a complete adjustment of other panels to match, as well as a repeat of the merge
operations.

If the air-cooled fins on the north side of the enclosure needed to be modeled, then they
could be included as a separate part, assuming they are bonded such that a contact conduc-
tance is appropriate between the two parts. If strong temperature gradients occurred in the
north side as a result of these fins (perhaps if the box were made of steel instead of aluminum,
for example), this might force an increase in the nodal resolution of that north-side rectangle,
especially as needed to calculate the contact effects correctly. Increasing the resolution of
this one side, however, would force a proportionate increase in the resolution of all adjacent

8 Strictly speaking, locating the nodes at the edges of the elements represents an extra approximation, as the
mass of those half-cells have been mathematically cantilevered. In other words, this is a very modest violation
of a formal finite difference method, and avoids other (much worse) approximations.

Figure 2-6    AutoCAD and Thermal Desktop Finished Box Model, Nodes Visible
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plates in order to maintain coincident nodes such that they can be merged. Additional mesh
controls9 are planned for future versions of Thermal Desktop that would help eliminate the
need for such a global escalation of model density, but for now such considerations must
be taken into account during model construction.

2.4.2   Example: Autoclave

An large industrial autoclave10 is designed to be heated by a gas burner on the bottom,
flaring at the top to provide a wider mouth as needed to accept a rack of medical articles for
sterilization. The wall is fabricated from stainless steel, but has been clad at the bottom with
a copper disk to help spread the heat from the burner. At the top, a bolted flange plate
contains a slot for an O-ring seal. Figure 2-7 depicts the geometry.

9 See also the treatment of the copper cladding in the next example, Section 2.4.2. In both cases, defining a com-
mon 2D surface between adjacent parts would allows the mesher to assure alignment of nodes for the purposes
of assigning contact, or for merging coincident nodes.

10 Essentially a high-pressure (and therefore higher-temperature) commercial pressure cooker that can include a
drying cycle.

Figure 2-7    Copper-clad Stainless Steel Autoclave with Sloped Sides
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A transient thermal model is needed to predict both start-up and shut-down times, in-
cluding heat losses off the bottom and sides (the lid is omitted from this discussion for
simplicity). In particular, various water fill levels will be investigated, including investigat-
ing an over-temperature scenario in which the water is depleted accidently, as needed to
investigate burner control strategies.

Because of the thick (and varying) walls and the low conductivity of stainless steel, a
3D thermal model (or at least 2D axi-symmetric) is required; 2D surfaces will not adequately
represent this device.

The thermally-irrelevant bolt holes and O-ring slots represent targets for omission when
constructing a solid model (or when suppressing features in an inherited CAD drawing).
Nonetheless, the complexity of the design borders on the limits of AutoCAD solid construc-
tion techniques. If the cross section of the cooker were rectangular with rounded corners
(e.g., shaped like a bread pan or an ingot mold), then Inventor would be the preferred method.
For an axially symmetric 3D solid, either tool could be used.

A recurring theme of this document is that the needs of the thermal model must
flow upstream to influence the type of geometric model created. This statement is in-
tended as a counterpoint to the idea that any geometric model can be turned into a sensible
thermal model. Such a notion of “import and mesh” is pervasive and appealing,11 but mis-
leading. Geometric models are built for machining (CAM), for validating interferences and
tolerances, for estimating mass and mechanical properties (including perhaps structural and
dynamic response), etc... but rarely are they built with the need for thermal/fluid modeling
in mind. Eliminating features such as bolt holes, fillets, and chamfers is certainly one ex-
ample of how a faithful geometric model could otherwise result in an unwieldy thermal
model. But there are other more subtle ways in which the thermal modeling requirements
can affect the geometric modeling approach.

For the case of the autoclave, can the boundary conditions, initial conditions, sensor/
control schemes, etc. be assumed axially symmetric? Is the flame applied evenly? Is the
unit tilted (such that the water level is no longer symmetric)? Is the autoclave situated in a
row with sister units such that environments are not symmetric? Is the rack of instruments
to be inserted also axi-symmetric?

Depending on the answers to these questions, a full 3D model might be required, whether
created in AutoCAD (assuming the design is not still changing) or Inventor (preferable if
vessel design changes are still being investigated). On the other hand, if symmetry can be
assumed, then a 2D mesh of the cross section can be extruded with identical nodes at each
circumferential slice (Section 6.4), resulting in several orders-of-magnitude increase in run-
times. In fact, it is probably a good idea to create the axisymmetric model even if the full
3D model is required, because the multiple orders-of-magnitude speed increase can be
exploited to run optimizations, sensitivity and uncertainty analyses, correlations to test data,
etc.

11 Software salespersons are surely tempted to present such “plug and play” capabilities as the standard, taking
engineering decisions out of the loop via automation.
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Therefore, both types of models will be constructed to illustrate the differences in ap-
proach and usage. The 3D model will be constructed in Inventor, and the axi-symmetric
model will be constructed in AutoCAD since a 2D surface is the basis of that model. In fact,
the AutoCAD model will be based on a slice of the 3D model, since it is easier to pick points
off an Inventor drawing than it is to create a complex cross section from scratch in AutoCAD.

2.4.2.1   Inventor Model of AutoClave (Full 3D)

The completed Inventor model is depicted in Figure 2-7. This section summarizes its
construction methods.

A rudimentary outline of half of the autoclave's cross section is created on Sketch1,
without the O-ring channel. A Fix constraint is placed to lock the shape to the origin.

The sketch takes shape as dimensions are added. The larger dimensions (e.g., overall
radius, height) are added first, then the smaller detail dimensions. Once the general cross
section is completed, the O-ring channel is added.12 A U-shaped channel is drawn, connected
to the top edge of the autoclave. The channel is dimensioned for size and distance from
outer circumference. Once the channel is fully constrained, the Trim command is used to
open the channel.

The sketch is finished and the Revolve command is used. The sketched profile is se-
lected and the y-axis (found under Origin in the model window) is selected as the axis of
revolution. The cross-section sketch (Sketch1) is now consumed by the Revolve command,
creating the feature Revolution1.

A new sketch (Sketch2) is created on the top of the part. The Point, Center Point
command is used to create a point on the surface halfway between the outside edge of the
O-ring channel and the outside edge of the autoclave. The sketch is finished, and the Hole
command is used, consuming Sketch2 into Hole1. Inventor automatically uses the center
point of the previous sketch. The Termination is switched to Through All and the diameter
is chosen.

Now that a hole exists, the Circular Pattern command is used. The feature selected is
the newly created hole, then the y-axis is selected as the axis of revolution, and the number
of occurrences is selected, generating Circular Pattern1 (which references Hole1).

The copper cladding is added to the bottom by creating a new sketch (Sketch3) on the
bottom face of the autoclave. The Offset command is used to create a slightly smaller version
of the circle13 that forms the base of the pressure vessel. The Extrude command creates the
geometry of the copper disk, consuming Sketch3 into the feature Extrusion1.

12 The O-ring and bolt holes are added for the sake of completeness of the resulting artwork, and to illustrate their
suppression or elimination in later steps. These extra steps also demonstrate more Inventor features. Of
course, a model generated by thermal analysts purely for their own use would not include such details.

13 The small ledge formed by this step is largely irrelevant to a thermal model, and only causes the mesher to use
a small element size as needed to resolve it. So again, this does not represent good modeling practices, but
rather it is demonstrated for completeness.
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2.4.2.2   AutoCAD and TDMesh Revolve Model of AutoClave (Axisymmetric)

For a full 3D model, the O-ring channel should be removed and the bolt holes suppressed.
But for an axisymmetric model based on the cross section, the full Inventor file is acceptable
since all that are needed are snap points.

To create this model, use Inventor Link or import an SAT file created by Inventor, and
snap a polyline representing the cross section in the XY plane as shown at the left of Figure
2-8 (a simplified Inventor SAT file has been used for visual clarity).

The region formed by this closed polyline can then be meshed in 2D (at the right of
Figure 2-8, noting a TDmesh is shown rather than the actual TDMesh Revolve object, again
for visual clarity). This mesh is then revolved about the Y axis (where a construction line
has been placed) using TDmesh Revolve (Section 6.4), resulting in the solid/surface model
shown in Figure 2-9. A sufficient number of layers (36 as shown) has been chosen to make

the resulting volumes and surface areas more accurate. Since the layers all contain the same
nodes (which is what makes the model axisymmetric), the cost of this high resolution is
minimal.

2.4.2.3   Thermal Modeling of the Autoclave

How should the copper cladding be handled? It is difficult to assign different material
properties within a single meshed part, at least unless an uneven interface (element by
element) can be tolerated. On the other hand, if two different parts are constructed, then
they must be thermally mated using large contact conductances, which can be inaccurate
and computationally inefficient. Future versions of Thermal Desktop will offer methods for

Figure 2-8    Polyline Cross Section Snapped on Simplified Inventor Model, Meshed
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constraining meshes such that merging nodes of adjacent parts is facilitated, or such that
contact between adjacent nodes is more accurate and efficient (e.g., the bonded fin plate on
the north side of the box in Section 2.4.1).

Until then, an assumption of a thin copper plate will be applied in this case, warranted
by the lack of gradients in the high-conductivity copper. The bottom surface elements of
the two models will be selected (using a careful cursor drag) and a thickness corresponding
to the copper cladding will be assigned. In other words, conduction in the 3D elements
representing the stainless steel will be augmented by superimposing 2D within-surface
conduction representing the copper cladding, and the extra capacitance of the copper will
also be appended to the nodes on the bottom disk.

Similarly, other surfaces must be selected (perhaps by placing into AutoCAD groups)
to impose other boundary conditions such as external natural convection on the sides, pool
boiling of water in the inside bottom, a heat load or radiation connection on the bottom
representing the burner, etc.

The number of SINDA nodes required in the full 3D model (Figure 2-1014) is about
1450, whereas the number in the axisymmetric model is only about 50. By itself, this results
in approximately 40 fold decrease in solution cost per time step or per steady state iteration.
In transients, the time constant of each node in the axisymmetric model is also much larger

14 Overlapping views of the surfaces and solids cause the mottled appearance of this figure, but this “defect” of
graphics makes it easy to see the elements, including the small elements that are formed at the recess formed
by the copper disk.

Figure 2-9    Axi-symmetry Model of Autoclave
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than that of the nodes in the full 3D model. In other words, few timesteps are required in
the axisymmetric model, resulting in a highly nonlinear decrease in total run times: hundreds
of simplified “what-if” cases can be run using the axisymmetric model in the same time it
takes to make a single full 3D transient run.

2.4.3   Example: Milled Flow Channels

A cold plate is formed by milling coolant channels into a relatively thick plate (Figure
2-11), with simple manifolding provided by a set of reliefs milled into the plate where the
channels meet. The cold plate will be topped by a flat plate (not shown).

Because of the thickness of the plate (0.5 units) compared to the depth of the channels
(0.125 units), a 2D approximation of the plate is questionable. Also, it is convenient to use
a geometrically faithful (realistic) representation of the flow channels as long as the mesh
resolution is not too high, such that FloCAD can calculate the flow areas, wetted perimeter,
etc. Therefore, this part will be modeled as a FEM solid.

Both AutoCAD and Inventor will be used to create the plate, in order to highlight the
differences in approach between the two tools. The drawings and part files are available for
inspection,15 so only a brief description is provided here.

15 These demonstrations are certainly not intended to teach efficient or even proper usage of either AutoCAD or
Inventor. Like the intended reader, the authors are thermal/fluid engineers and not CAD experts.

Figure 2-10    3D Mesh of De-featured Autoclave
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2.4.3.1   Creating the Cold Plate in AutoCAD

The first step is to create a series of construction points placed at critical locations through
the drawing: at opposite corners of the plate, at key locations where the centerlines of the
flow channels will pass (including tangents of any arcs), at the centers of holes or where the

Figure 2-11    Coolant Channels Milled into a Cold Plate
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race-track-shaped manifold reliefs will be located. Approximately 20 such points are re-
quired. These points will make construction of objects (circles, polylines, etc.) easy and
accurate by acting as snap points.

A solid representing the outer envelope of the plate (0.5 x 10 x 20 units) is created, either
by using the box option or extruding a rectangular region.16

Next, two solid cylinders representing the through holes17 are created and subtracted
from the plate. Two are needed, since they are consumed in the boolean subtraction opera-
tion.

A race-track shaped solid is created via a union of a box and two cylinders. The thickness
is made equal to 0.25 units (the depth of the resulting cut). This solid is copied, and one of
each is used to make the manifold relief cuts (boolean subtractions) near the through holes.

Four polylines are constructed along the centerlines of each flow channel at the surface
of the plate.

A new UCS is created such that the XY plane is perpendicular to the plate. Four rect-
angular passages, 0.5 by 0.25 units, are created representing the cross section of the flow
channels. The sweep operation is then used to generate the solids that will be used to cut
the flow channels. This is why the four cross section profile rectangles were twice the
thickness of the cut required (0.5 by 0.125 units): they are swept along the centerline which
was at the surface of the plate, and so they appear to stand out from the plate: 0.125 inside,
and 0.125 outside. Subtraction of these four swept solids from the plate results in the finished
plate.

Figure 2-12 depicts the final object, including the mesh preview. Construction objects
(points, centerlines, and extra copies of various cut objects) are retained for inspection on
an invisible layer.

At each significant stage of construction, a copy of the AutoCAD drawing file is saved
and archived. The purpose of this action is to provide a starting point should any significant
dimensions change and a new plate must therefore be constructed. This action underlines
the central flaw in the AutoCAD approach for such a complex object: changes in the plate
will be difficult to accommodate without starting over.

Another difficulty in the AutoCAD approach is the degree of care that must be taken
during construction, such that slivers are not created that will cause a subsequent meshing
task to either fail or to result in an inappropriately detailed mesh (Section 6.2.3). In fact,
this is exactly what happened during the first attempts to construct this part. The causes of
the resulting slivers was not clear, but appeared to be due to slight errors in the sweep
operations.

16 An extrusion is preferable since the extruded depth can be changed later without losing other construction
steps.

17 Neglecting these holes simplifies the resulting model with negligible loss of accuracy. They have been added
to this model for explanatory purposes, not modeling purposes.
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2.4.3.2   Creating the Cold Plate in Inventor

A rectangle is created, constrained at one corner to the origin, and dimensioned (10 x
20). This forms Sketch1. It is extruded 0.5 units, which consumes Sketch1 into the
Extrusion1 feature.

A new work plane (Sketch2) is created on the surface of the plate, and two 1 x 1 squares
representing part of the manifold reliefs are sketched in opposite corners. They are dimen-
sioned and located relative to the edges of the plate. Two circles are added to each end of
the squares, their centers constrained to the middle of each side of the squares and their
diameter constrained to the sides of the squares, completing the two race-track shapes.

Lines representing the periphery of the outermost two channels are sketched on Sketch2,
being careful to avoid snapping to the manifold race-track objects, and using parallel/per-
pendicular constraints to position the lines. The lines are dimensioned relative to the edges,
and the distance between them (the channel width) is set to 0.5 units.

Extend is used to connect the lines to manifold objects, without yet applying fillets nor
trimming lines.

Next, four lines of arbitrary length are added to Sketch1 (not snapped, but parallel to
each other) in the middle area. These will form the channel walls of the middle two passages.
These lines are then constrained by channel width, distance away from previous channels,
etc. 

Figure 2-12    Meshed Cold Plate in AutoCAD

Note: 90 degree max turning angle is 
used to avoid excessive resolution at 
through-holes and reliefs
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Continuing Sketch2, diagonal construction lines (45 degrees) are drawn from the from
centers of the inside circles forming parts of the racetrack. These lines can be used to crate
the slanted channels walls via the Offset command. These new lines and Extended to the
manifolds and to the channel walls (the four lines created in the last paragraph), with any
excess Trimmed.

To complete Sketch2, 2D fillets (inner radius + channel width = outer radius) are applied
to the flow channels where they curve.

A profile of manifold race-tracks are extruded into the plate (cut), which consumes
Sketch2 into feature Extrusion2. Sharing Sketch2 and cutting the regions formed by the
channels into plate using a similar operation yields feature Extrusion3.

The through holes are created last at the center points of the previous sketch's circles
(Sketch 3 and Sketch4, consumed by Hole1 and Hole2, respectively).

The finished part is shown in Figure 2-11. When saved as a SAT file, in can be imported
into AutoCAD and meshed by Thermal Desktop, resulting in an identical model to that
shown in Figure 2-12. However, if any dimensions change, the Inventor part can be quickly
updated and re-exported to AutoCAD, whereas the AutoCAD-drawn part (Section 2.4.3.1)
is largely indelible.

Also, slivers are rare for adequately dimensioned and constrained parts built in Inventor
and exported to AutoCAD in SAT format. (Slivers can occur using AutoCAD construction
techniques as mentioned in the previous section, but are most likely to occur as a by-product
of CAD translators as explained in other Section of this manual.)
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3    Importing CAD Geometry

3.1 Step AP203

Importing of STEP information is significantly different than all the other Import and
Export options. The STEP translator is written by Autodesk and is available through Au-
toCAD Mechanical or Autodesk Mechanical Desktop (bundled with Autodesk Inventor
Suite). Users who purchase CAD functionality along with Thermal Desktop have access to
the STEP translator. The STEP translator is accessed typing the command STEPIN in the
command line.

The AutoCAD STEP Translator enables data exchange using STEP AP203, which is
called Configuration Control of 3D Design Data. For the purposes of Thermal Desktop,
AP203 provides B-rep solids, surfaces and wireframes.

STEP import is a way to get CAD data from another CAD system such as PRO/ENGI-
NEER, I-deas, CATIA, UNIGRAPHICS and others. The user must EXPORT a STEP file
from those CAD systems. The export command on most CAD systems will contain options
for the user. Generally, it is best to try several different options to see what works best for
the system being used once it is imported into AutoCAD. Some of the options may produce
so much information, that the system may not be able to handle it in terms of memory and
graphics limitations.

For more information on STEP translation, select the Help button on the STEPIN trans-
lation form.

3.2 IGES

Importing of IGES information is significantly different than all the other Import and
Export options. The IGES translator is written by Autodesk and is available through Au-
toCAD Mechanical or Autodesk Mechanical Desktop (bundled with Autodesk Inventor
Suite). Users who purchase CAD functionality along with Thermal Desktop have access to
the IGES translator. The IGES translator is accessed typing the command IGESIN in the
command line.

IGES import functionality only imports geometrical information such as lines, points,
arcs, circles, etc. This information may then be used to construct Thermal Desktop type
surfaces and elements using these entities and the key points on these entities.

IGES import is a way to get CAD data from another CAD system such as PRO/ENGI-
NEER, I-deas, CATIA, UNIGRAPHICS and others. The user must EXPORT an IGES file
from those CAD systems. The export command on most CAD systems will contain options
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for the user. Generally, it is best to try several different options to see what works best for
the system being used once it is imported into AutoCAD. Some of the options may produce
so much information, that the system may not be able to handle it in terms of memory and
graphics limitations.

When exporting from I-deas, some users have determined that it is best to set the Surface
Types to Export option to none. This option will export just the wireframe geometry which
can easily be used as reference for building Thermal Desktop surfaces.

For more information on IGES translation, select the Help button on the IGESIN trans-
lation form.

3.3 ACIS

AutoCAD is capable of importing geometry objects stored in SAT (ASCII) files using
the ACISIN command or Insert > ACIS file menu command. ACISIN converts the model
to a body object or to 3D solids and regions if the body is a true solid or a true region.
AutoCAD is limited to reading ACIS version 7.0 and earlier.

Once imported, the geometry may be used to snap Thermal Desktop objects to the correct
dimensions or may be meshed using TDMesh as described in the Thermal Desktop Ad-
vanced Modeling Guide in a seperate volume.

3.4 DWG

AutoCAD DWG files, including those created from Thermal Desktop, may be inserted
into other drawing files using the Insert > Block menu command. The resulting dialog box
provides the means to specify the insertion point and define scaling factors for the file, or
block, being inserted. If the explode option is not selected on the Insert block form, the user
must type EXPLODE, or select Modify > Explode, to separate the block into its individual
entities.
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4    Working with CAD Geometry

4.1 Simplifying CAD Geometry

Simplifying geometry is probably the most important step of advanced modeling. With-
out simplification, an automated mesher, such as TDMesh (Section 6 on page 6-1), can focus
or fail on a section of the model that has no bearing on the thermal results. An extreme
example, but not uncommon, would be a part with threads included in a bolt hole: it can be
argued that the bolt hole (or at least its location) may be necessary for a thermal analysis,
but the threads would have no effect. The mesh that would be required to capture each thread
face would be extreme (if meshing was even successful) and would unduly complicate the
model.

4.1.1   AutoCAD

AutoCAD has some basic capabilities for modifying geometry for simplification. If
solids are present, opening the Solid Editing toolbar will help, otherwise most commands
are found under the Modify and Modify > Solid Editing menus. For simplifying the model
the following sections will describe some of the more common editing tools.

4.1.1.1   Explode

The Modify > Explode menu option will break a solid into its faces. The primary benefit
of this is simplifying a solid to just the face so that the extrude or revolve mesher can be used.

Treating thin objects as solids instead of surfaces can cause undesirable mesh densities
when the part is meshed. An exaggeration of this effect is presented in Figure 4-1. In the
top part of the figure, the mesh generated to represent a thin solid plate contains many small
elements at the edges: the small characteristic dimension of that thickness has caused the
local cell size to shrink at the edge.

In bottom part of Figure 4-1, a surface has been meshed instead (perhaps after exploding
the solid). This 2D mesh can be assigned a virtual thickness within the TDMesh edit form,
but if a geometrically faithful thickness is required (perhaps for radiation), then the 2D mesh
can be extruded (Section 6.3). (Nonplanar surfaces can also be extruded along local surface
normals.) If the thickness is large enough (or if the conductivity low enough), several 2D
mesh layers can be used. If instead, the thickness is small enough (or conductivity high
enough), these layers can contain the same node numbers when the TDmesh Extrude option
is used, resulting in a model which is geometrically faithful but thermally approximate.
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4.1.1.2   Select and Modify Subobjects

By holding the <CRTL> key and clicking on edges and faces, the edge or face of a solid
can be individually selected. This same method allows selecting the original objects of a
solid created by boolean operations. Once selected, the grip points of a subobject will become
available and the subobject can be edited (e.g. - the radius of a cylinder used to create a hole
in a block).

4.1.1.3   Delete Face

The Modify > Solid Editing > Delete Face command allows the user to remove a face
from the solid. The faces can be selected using the method described in the previous section.
AutoCAD will attempt to heal the solid (fill the gap) by extending existing faces to re-

Figure 4-1    Meshing a Thin Solid (top) versus Meshing a Surface (bottom)
4-2 Working with CAD Geometry



enclose the solid object. Examples where this command would be useful would be unnec-
essary bolt holes, fillets, or chamfers. In some instances, an object may not be healable.
When this happens, AutoCAD will not delete the selected face and note that the objects
could not be healed. Certain faces may need to be deleted in a specific order for healing to
take place.

Figure 4-2 shows an electronics cover with some unnecessary details which are high-
lighted in red and some potentially unnecessary details highlighted in yellow. These are all
faces that may be deleted, but the chamfer around the edge of the base cannot be deleted in
one step since it is not one face Along each straight edge is a face and along each curved
edge is a face. If any one of these faces is deleted, a discontinuity will occur at the next face,
casuing AutoCAD to fail the healing process. The solution to this is to remove the rounded
corners of the base, followed by the chamfer faces at each corner, and then the chamfers
along the straight edges can be removed (as seen on the left of Figure 4-2). The other
highlighted surfaces could be deleted directly.

4.1.2   Autodesk Inventor

The modification features described below will be in slightly different locations depend-
ing on whether Inventor is in Part mode or Assembly mode.

4.1.2.1   Select and Modify Subobjects

In Inventor, a selection tool provides options for which items will be given priority of
selection. For assemblies, options include component, part, feature, faces and edges, and
sketch features. For parts, options include feature, faces and edges, and sketch features.
Parts, faces, edges and sketch features will be selectable for any part. The other options will

Figure 4-2    Simplifying a solid
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only be available if the part or assembly was created within Inventor or the information was
imported with the model. For Inventor, <SHIFT> or <CTRL> must be held down to select
multiple objects.

4.1.2.2   Delete Face

To delete faces, lumps1 or voids2, click the Delete Face tool on the Feature toolbar. To
maintain a solid object after deleting a face, select the Heal option, otherwise the remaining
faces will form a surface. As opposed to AutoCAD, multiple surfaces can be selected and,
if congruent, will be deleted as a single face. In the example, above, the faces of the chamfer
around the base plate can all be selected together and deleted at one time without having to
delete any other surfaces. If the part was created in Inventor, the feature (chamfer, blend,
hole, etc.) will be selectable and can be supressed or deleted.

4.1.2.3   Access to Inventor Data from Thermal Desktop

To use Inventor geometry data in Thermal Desktop, the user must decide how the ge-
ometry will be used: as scaffolding for the thermal model; or as a basis for TDMesh. For
the former, the user may export the geometry from Inventor using ACIS format or, using
AutoCAD Mechanical, link from AutoCAD to the Inventor file. Linking will allow updates
made in Inventor to be highlighted in AutoCAD, but some limitations do exist such as scaling
a Thermal Desktop model for new units does not scale the image of the linked Inventor file.

For use as a basis for TDMesh, the Inventor file must be exported using ACIS (not the
only possible method, but the preferred format). When the ACIS format file is imported to
AutoCAD, the geometry will be available for meshing.

4.1.3   Upstream Tools

Table 4-1 on page 4-5 is a partial list of tools that could be used upstream of Thermal
Desktop for simplifying geometry or simply translating from one format into another. This
list is based on datasheets and not experience. This section is not comprehensive, only an
introduction to some tools that may be useful for simplifying geometry or possibly trans-
lating into formats suitable for importing into Thermal Desktop. This list in not an endorse-
ment of any tools or products. The product names used in this table are for identification
purposes only. All trademarks and registered trademarks are the property of their respective
owners. In the list, the user will find some capabilities of the software and one or more
suggested paths or supported file formats to move the data from the tool to Thermal Desktop. 

1 A group of faces that may contain some or no void. A part or surface of a body should have at least one lump.
2 A group of faces that define an internal hollow space.
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Table 4-1 

Tool Vendor Capabilities

Pro-Engineer PTC • Simplified representations

• Mid-planing

Suggested paths to Thermal Desktop

• Pro-Engineer > Inventor > ACIS

• Granite > Inventor > ACIS

• ACIS > Inventora > ACIS

• STEP

FEMAP Siemens • Meshing

• Mid-plane meshing

Suggested paths to Thermal Desktop

• FEMAP Neutral

• NASTRAN mesh

• ACIS

• Parasolid > Inventor > ACIS

PATRAN MSC • Meshing

Suggested paths to Thermal Desktop

• NASTRAN mesh

SolidWorks Dassault Systemes 
SolidWorks Corp.

Suggested paths to Thermal Desktop

• ACIS

• Parasolid > Inventor > ACIS

SpaceClaim SpaceClaim Corp. • History-free model manipulationsb

Suggested paths to Thermal Desktop

• ACIS

KeyCreator

Realyze

Kubotek • History-free model manipulations

Suggested paths to Thermal Desktop

• ACIS
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4.2 Snapping TD Objects to CAD Geometry

Each custom Thermal Desktop surface has a collection of grips (please refer to the
AutoCAD User’s Guide for more information about editing with grips) that are used to
graphically modify the shape of the surface. For example, the cylinder has grips to change
its location, orientation, height, radius, and start and end angles. Using grips in combination
with snap modes and the geometry calculator (AutoCAD ‘cal command) enables easy and
powerful geometry construction. Any grip may be used to move a surface by toggling the
grip mode to move mode by pressing the space bar or entering the letters mo at the command
prompt.

Graphical objects in AutoCAD, including Thermal Desktop objects, define snap points
for various locations on the objects. Examples of object snaps are: end point, mid point,
center point, intersection, extension, and node point. Setting the running object snap
mode to end, mid, center, and node will automatically select these points during picking
operations. Holding down the <Shift> key and then holding down the right mouse button
may be used to bring up a pop-up menu to select a snap mode during picking operations.

Using the grip points with object snaps allows the user to match the Thermal Desktop
objects to the underlying geometry, thus providing the benefits of the Thermal Desktop
surfaces (true curvature for radiation calculations, parameterization, etc.) while verifying
an accurate representation of the geometry.

IronCAD IronCAD • History-free model manipulations

Suggested paths to Thermal Desktop

• ACIS

NX Siemens Suggested paths to Thermal Desktop

• Parasolid > Inventor > ACIS

• FEMAP > FEMAP Neutral

a. C&R Technologies’ experience has shown that ACIS from Pro-Engineer should be healed within 
Inventor to provide a usable geometry.

b. History-free model manipulations allow the user to model features such as holes, fillets, cham-
fers, etc. without knowledge of how the feature was created. The tools with these capabilities 
have varying levels of feature recognition.

Table 4-1 

Tool Vendor Capabilities
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5    Finite Element Models

Many times thermal analysts must work with structural analysts in order to allow tem-
perature-dependent stress calculations to be made. Finite elements models may be imported
in one of two ways: as graphics or as nodes and elements. Both methods are available using
the Thermal > Import > * menu option, where the ‘*’ represented the finite element file
format. If temperature results will be mapped back to the structural model, the structural
model can be imported as graphics and the mapping option set by using the Post Processing
Data Mapper. Detailed instructions for importing models are provided in the Thermal Desk-
top User’s Manual, in another volume.

5.1 Importing FE Model as Nodes and Elements

If the user wishes to simply import the thermal model from a finite element preprocessor, 
the finite element model should be imported as a thermal model (nodes and elements). 
This may be the process if a third-party preprocessor , such as FEMAP, were used to gen-
erate the thermal model. The implications of this choice are:

• The thermal model is already built.

• The thermal model resolution is determined upstream of Thermal Desktop.

• Curved surfaces are faceted and radiation will not account for actual curvature.

• 1:1 node association between thermal and structural model (this typically results in an
overly defined and complex thermal model and is not necessary for mapping results).

• The analyst must verify that elements and boundary conditions have been imported
correctly.

Thermal Desktop will conduct tests on the imported elements for quality. Any elements
which are degenerate (multiple nodes of the same element in the same location) or of poor
quality will be added to an AutoCAD group named BADELEMS. Additionally, if multiple
elements are co-located (elements share the same node set), two groups will be created: one
of the co-located elements will be placed into DUPELEMS2 and all other co-located ele-
ments will be placed in DUPELEMS. The DUPELEMS group can be deleted to ensure only
one element per node set. The Model Browser can be used to list out AutoCAD groups so
the user can check to see if these groups exist and to see what elements have been placed
in them.
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5.2 Importing FE Model as Graphics

If the user wishes to generate the thermal model using Thermal Desktop surfaces, the 
finite element model should be imported as graphics. The implications of this choice are:

• The analyst must build the thermal model.

• The analyst maintains control over model resolution.

• The analyst can choose between finite element and finite difference objects.

• The analyst must apply all boundary conditions.

When the finite element file is imported, the mesh appears as a graphical object. By
editing the graphical object (select the mesh and choose Thermal > Edit), the user may
choose the display options for the mesh displayer, such as wireframe outline, wireframe
exterior faces, etc. This graphical object can be used for object snapping for either Thermal
Desktop objects or AutoCAD wireframes, surfaces, or solids to be used for generating
geometry that can be meshed using TDMesh.

If the results of the thermal model will be mapped back to the structural model, then the
post processing data mapper is recommended as described in the following section. 

5.3 Mapping Results

Using the Post Processing Data Mapper is described in the Thermal Desktop Users
Manual, but for purposes of Advanced Modeling, the data mapper object can be used similar
to importing a finite element model as graphics (as described in Section 5.2). The benefits
of using the data mapper are: 

• a graphical representation of the finite element mesh will be diplayed;

• the mesh graphics may be relocated (translated and/or rotated);

• the thermal model can be verified to represent the same geometry represented by the
structural model;

• the mesh may be reimported;

• the thermal model results may be mapped back to the structural analysis mesh in its
own format accounting for all translations and rotations;

• the mapped results can be verified on the mapper.

In addition to these benefits, the analyst also maintains control of the resolution of the
thermal model and the types of objects used for the thermal analysis.
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6    Meshing

The Thermal Desktop meshing utility, TDMesh, is a basic meshing tool developed to
bridge the gap between building models using native surfaces and solids, and importing
meshes from third-party applications (e.g., structural analysis software). TDMesh can be
used for quickly creating simple 2D or 3D finite-element meshes using CAD geometry that
is either created within AutoCAD or imported into AutoCAD.

TDMesh is recommended if the part geometry is too complex to be represented by
Thermal Desktop finite difference surfaces or solids. Native conic surfaces are generally
preferred when the geometry matches these surfaces, since the surface curvature is mathe-
matically precise, rather than approximated by flat elements. Native surfaces also allow for
a coarser nodal breakdown while still maintaining geometric fidelity (when a coarse break-
down is acceptable for accuracy). However, for geometry that does not fit well with the
standard set of conic primitives, TDMesh provides a convenient and quick method for
generating thermal models.

While TDMesh provides the ability to model geometry that is not easily described by
the standard set of conic primitives and finite difference solids, overly complex geometry
is problematic as well. First, it might not be successfully meshed by TDMesh. Or, if the
complex object is successfully meshed, the resulting model might be slow to solve and
perhaps cumbersome to use (e.g., when assigning boundary conditions) because of the
enormous number of elements. Therefore removing any details not required by the thermal
analysis (small holes, fillets, chamfers, etc.), and using a simplified starting point (e.g., a
thickened or extruded mid-plane instead of a thin solid) will be well worth the effort. TDMesh
is not the starting point: it should be invoked after appropriate preparations have been made,
as emphasized in other sections of this document.

For arbitrary surface and solid geometry, TDMesh creates triangular surface elements
and tetrahedral solid elements. More advanced techniques than such “tri-tet” meshes are
available in dedicated (third party) mesh preprocessors. For these reason, and for cases
where TDMesh fails to accommodate a geometric detail that cannot be adequately simpli-
fied, it should be noted that some meshing needs will be best met by third-party mesh
preprocessors. In these situations, the analyst should refer to the section on importing finite
element nodes and elements (Section 5 "Finite Element Models" on page 5-1).

TDMesh (Section 6.2) will produce triangular elements on an surface (e.g., AutoCAD
region or surface). An AutoCAD region is a planar surface that is constructed out of bound-
ing wireframes. The bounding wireframes may be straight lines, arcs, or splines. Regions
may be modified by boolean operations, such as subtracting a circle from a region to create
a hole.

An AutoCAD surface can be a simple or complex surface created by lofting, extruding
or revolving an open wireframe, or by exploding a solid. AutoCAD solids can be created
in many ways including boolean operations, lofting, extruding, and revolving surfaces or
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closed wireframes (the starting vertex is coincident with the ending vertex). When TDMesh
is applied to an arbitrary solid (3D) object, the user will have the choice of generating only
triangular surface elements, or generating only tetrahedral solid elements, or both.

TDMesh may also be applied to AutoCAD polygon meshes. An AutoCAD polygon
mesh is a collection of vertices and faces used for geometric display. Polygon mesh faces
are either three or four sided polygons. An AutoCAD polygon mesh can be specified man-
ually by creating vertices and faces, by extruding or revolving curves, or by fitting a surface
between four boundary curves (e.g., the AutoCAD command edgesurf). AutoCAD polygon
meshes are the original way surfaces were geometrically represented in AutoCAD, before
the recent introduction of advanced NURB based surface and solid modeling. When TD-
Mesh is applied to polygon meshes, the FEM mesh generated matches the vertices and faces
of the polygon mesh, no further subdivision is performed. Triangular or quadrilateral ele-
ments are created, depending on if the face is a three or four sided polygon.

TDMesh also supports extrude and revolve operations for regions, arbitrary surfaces,
and polygon meshes. Again, the final output may consist of only surface elements, or only
solid elements, or both. However, because of the nature of the extrusion or revolution pro-
cess, the surface elements are not always triangular (and in fact, they are often quadrilaterals
on side surfaces), and the solid elements are not always tetrahedrons (instead, they are often
pentahedrons). Furthermore, unlike meshing an arbitrary solid using TDMesh, certain op-
tions are available when extruding or revolving: the ability to selectively generate and
customize key surfaces. This capability facilitates application of boundary conditions (e.g.,
radiation, convection) and model reduction via the exploitation of symmetry.

In the following discussion, a part is a CAD surface or solid that is the basis of the mesh
to be generated. A “preview mesh” (or simply preview) is the geometric mesh made from
and corresponding to the part. The geometric mesh is called a “preview” because it is simply
a set of points and lines, and is not yet a thermal model. The user may examine the preview
to be sure it meets the needs of the thermal analysis. If acceptable, the preview can be used
as the basis of generating a TD finite element model (FEM mesh). If the part is modified,
and/or meshing parameters are modified (e.g., finer resolution is chosen), then the preview
and the FEM mesh may be easily regenerated.

6.1 Final Preparation for Meshing

Section 2 described how to build CAD parts in AutoCAD,1 Inventor, and other software.
Section 3 described how to use imported CAD parts, and Section 4 describes how to prepare
parts before or after importing such that sensible and efficient thermal models are possible.

1 At the very least, the reader should be familiar with creating AutoCAD regions and solids, and with the Union, Sub-
traction, and Intersect commands before continuing.
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This subsection therefore does not describe geometric preparations, since they are cov-
ered in prior sections. Instead, the preparations for efficient display of meshes are listed.
Meshes tend to be geometrically complex to draw, and so tips for accelerating their display
and refresh rates are well worth noting.

First, consider turning off the visibility of Thermal Desktop nodes by unchecking the
TD/RC Nodes button on the Graphics Visibility tab of the Preferences option as de-
scribed in the main Thermal Desktop User’s Manual. The locations at which nodes exist
will be obvious as the vertices of the resulting mesh, and rarely will the user need to select
and edit FEM mesh nodes directly.

Second, consider turing off AutoCAD’s selection preview. By default, when the cursor
passes over a mesh, it will be highlighted as a prompt. However, highlighting forces the
redraw of every line in the mesh, which can be considerable even if some lines are hidden,
per the options described in Section 6.2.5.1. To avoid this effect, in AutoCAD use the Tools-
>Options->Selection option (or type options at the command prompt and choose the Se-
lection tab), then turn off Selection Preview (at least “When no command is active”). For
Mechanical Desktop users, use Assist->Options->Selection to reach the equivalent form.

The preview may be displayed as a wireframe outline of just the edges of the mesh, a
wireframe of the elements with internal faces hidden, a wireframe of internal and external
elements, a solid shaded view of just the external faces, or a solid shaded view of both
internal and external elements. Different display options may be selected for post processing
mode and in regular model mode. (See Section 6.2.5.1)

The default mode when model building is to show a wireframe of internal and external
elements, and the default mode in post processing is to show a solid shaded view of the
external faces. When in model building mode, after the resolution of the mesh has been
examined and deemed acceptable, the display option may be changed to show a wireframe
of just the edges to increase graphics performance.

The preview will post process data in post processing mode. Therefore, the nodes and
elements that have been created from the preview may be hidden for better graphics perfor-
mance.

6.2 TDMesh

TDMesh is used to create triangular finite element meshes of AutoCAD regions or
arbitrary AutoCAD surfaces. It may also be applied to arbitrary solids, with the option of
creating only triangular surface elements, or creating only tetrahedral solid elements, or
both simultaneously (which is the default). TDMesh can also generate FEM meshes from
AutoCAD polygon mesh surfaces.

Once an region, surface, or solid (“the part”) has been constructed, or imported and
simplified if necessary, TDMesh can be invoked. As will be shown, the generation of a
thermal model from a geometric object is a multi-step process:

•   Generation of the geometric mesh (preview mesh, or simply preview) from the 
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part, with the creation of the corresponding Mesh Controller

•   Assignment of surface and/or solid element thermal material properties and 
boundary conditions (e.g., insulation, radiation).

•   Generation of thermal elements and nodes (FEM mesh) from the preview

Usually, these three steps should be performed in the order listed above. However, a
significant feature of the TDMesh design is that any of the three steps can be revisited at
any time using the Mesh Controller. In fact, the underlying part can be moved or modified
as well. Of course, some modifications may require the deletion and regeneration of the
FEM mesh (TD nodes, etc.) as part of the revision process, but the user effort required to
reconstruct a new FEM mesh has been minimized.

Once a preview (geometric mesh), thermal properties, and FEM mesh have all been
created, the user can revisit earlier decisions without losing all of their work. As with any
TD object, node, surface, and solid properties can be altered at any time, either at the element
level or at the Mesh Controller level (which will override any element-level customiza-
tions). The preview mesh itself can be revised as needed (perhaps to increase or decrease
mesh resolution). While this step will necessarily require deletion and regeneration of the
FEM mesh (and therefore any element-level customizations), any node, surface, or solid
properties that have been defined using the Mesh Controller will be preserved such that a
new FEM mesh can be immediately generated using the revised preview mesh. However,
please also note that certain boundary conditions such as heat loads, contactors, etc. will be
lost if the FEM mesh is deleted or regenerated.

Modifying the underlying part (surface or solid) will require that the preview be regen-
erated, and this in turn requires that the FEM mesh be regenerated as well. The Mesh
Controller manages the regeneration of the preview, the deletion of the previous FEM mesh,
and the creation of the new FEM mesh with the previously used node, surface, and solid
properties, making such modifications easy to accomplish.
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6.2.1   Generating a Preview (Mesh Controller)

To construct a mesh of a planar region, surface, or solid, type tdmesh at the Command
Prompt, or select the  icon on the toolbar, and then select the part to be meshed. This
action invokes the creation of a new Mesh Controller object. The Mesh Controller pro-
vides access for later editing and further mesh construction steps that can be deferred if
needed. The Mesh Controller dialog will appear (Figure 6-1).

Selecting Generate Preview... invokes the following form (Figure 6-2), which con-
trols the generation of the geometric mesh or preview. The dialog is shown for a mesh
controller used on a 2D part. The options for adjusting the mesh resolution are covered in
Section 6.2.2.

Geometric 
(Preview)
Mesh Control

Element, 
Properties
Control

FEM Mesh
Control

Geometric
Mesh Status

FEM Mesh
Status

(Grey for
2D parts)

Figure 6-1    Thermal Desktop Mesh Controller (surface, no mesh yet generated)

Mesh
Resolution
Control

(Grey for
2D parts)

Figure 6-2    Mesh Generation Options for a Surface Part
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When Generate Preview... is invoked for a solid part, the following form (Figure 6-
3) appears. Again, mesh resolution controls are described in Section 6.2.2. The two options
that become active at the bottom of the form when the Mesh Controller is applied to a solid
will now be described.

If the user requires a thermal model of the surface (to which radiation, convection, etc.
can be applied), check the Generate Surface Mesh Preview button. If the thermal re-
sponse within the solid is required, also check Generate Solid Mesh Preview. (Having
both options checked is equivalent to “surface coating” a solid FE mesh.)

It is possible to neglect either the solid preview or the surface preview, which means
that one of the corresponding FEM meshes will not be generated in later steps: only an
uncoated solid or only a hollow surface model is needed. For example, the surface preview
mesh can be skipped if no surface area effects such as radiation, convection, or contact will
be needed (which would be unusual). More commonly, the solid geometric mesh can be
skipped if a “hollow” object is desired, keeping in mind that a mathematical (not displayed)
thickness can be assigned to any TD surface.

When a new Mesh Controller is invoked, the controller is placed on a layer named
“TDFEM_MC_label.id” and the underlying part (surface or solid) is placed on a layer named
“TDFEM_PRT_label.id” (with visibility turned off), where label is the optional user-as-
signed label (Section 6.2.5.1) and id is the TD-designated Mesh Controller ID (e.g., “348”
or “1A4”). Section 6.2.5.2 describes how to use these layers to easily control the visibility
of each component of a TD mesh. If a Mesh Controller is deleted, the part will be restored
to its original layer.

6.2.2   Controlling Mesh Resolution

The methods for controlling the resolution of meshes will be provided by example. A
2D planar example will be described in detail. This discussion is also applicable for a 2D
mesh on an arbitrary curved surface, or 3D mesh on an arbitrary solid. For the TD Mesh
Extrude and Revolve options (Section 6.3 and Section 6.4, respectively), the mesh resolution
is applied first to the base surface object, and then extruded or revolved into a solid.

Preview Mesh
Resolution
Control

Generate surface mesh

Figure 6-3    Mesh Generation Options for a Solid Part

Generate solid mesh
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The example surface to be meshed is displayed in Figure 6-4. Note that this drawing
has units of inches, with the largest dimension of the part shown being approximately 1/2
inch.

The default options for the mesh preview appear in Figure 6-2. Since the part has no
curved edges, the “Max Turning Angle” is irrelevant for now (it will be described later).
Therefore, the resolution of the resulting mesh is controlled by one of two options shown
at the top of that form as selected by the radio buttons:

•   The fraction of the maximum dimension of the part.

•   The absolute size of the largest element length along any edge. Note that the 
default is 1 meter (39.37 inches). This is usually not a good starting value, and 
should be modified appropriately by the user.

Normally, the Fraction of Max Dimension option should be used, as it automatically
adjusts the size of the element to the size of the part. The alternative, the Absolute Size
option, is intended to help make meshes that directly correspond to other meshed parts, such
that subsequent merging operations are facilitated because nodes will be coincident. For
example, the Absolute Size option could be used to ensure that edges of a box (whose faces
are meshed as separate parts) can be merged since the nodes in each face will then be
coincident along the common edges. (Note that changing the resolution of either part’s mesh
will then force the user to repeat the merge operation.)

Figure 6-4    Example Surface to be Meshed
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The default value for the relative mesh fraction is 0.1, meaning that 10% of the largest
dimension of the object will dictate the element size. For the part shown above (Figure 6-
4), the default settings result in the following mesh (Figure 6-5):

A Mesh Controller has been created by generating this preview mesh, with the tag
visible to the right of the surface (“1D53” in this case). This controller can be relabeled
using the Set Label... button in Figure 6-1, as described in Section 6.2.5.1. The Mesh
Controller can be accessed in the Model Browser, or edited directly in the drawing as can
any other TD object.

Note that the size of the thin protrusion at the right of the part has not dictated the size
of the mesh, although smaller-than-average elements might be required to deal with the
sharp corner and the thin region itself. Instead, the 10% fraction has been applied to the
longest length.

The most coarse mesh that can be created for this object, with a fraction of 100% (1.0),
is shown in Figure 6-6. Even though the fraction calls for one element along the longest
length, other internal parameters override this in order to capture detail and provide a smooth
progression of element sizes. Each edge will have at least one element.

Figure 6-7 shows a mesh that is more finely resolved than the default: a fractional
resolution of 0.03 (3%). Note that the number of nodes that will be generated rises approx-
imately with the square of the number of elements along the edge. In other words, the model
size will be proportional to 1/F2, where F is the fraction employed. For a solid part, the
model size grows even faster: 1/F3. This means a FEM model of a solid object meshed with
F=0.01 will be roughly three orders of magnitude times larger than one meshed with F=0.1. 

The solution costs for radiation calculations and for transient thermal analyses will rise
even faster: requiring a total growth of perhaps six orders of magnitude in solution times!
Small fractions should be used sparingly, and values below 0.01 should be avoided if
possible. Often, what is important to thermal analyses is a mesh fine enough to adequately
represent total volume and surface area, and meshes fine enough to resolve detailed internal
temperature gradients are often a luxury rather than a necessity.

Figure 6-5    Example Surface, Default Resolution (Fraction = 0.1)
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In fact, if the fractional or absolute control parameter is too small, the mesher itself may
take an inordinate amount of CPU time to compute the preview mesh. If a too-small reso-
lution parameter is entered accidently, use the escape key (ESC) to abort mesh construction.

To illustrate the effects of the Max Turning Angle control, a circular hole will be cut
in the surface presented in Figure 6-4, resulting in the following default mesh (Figure 6-
8). Although some of the turning angles around the hole are smaller than the default value
of 45 degrees (especially as needed to encompass the thin section above the circle), the
maximum turning angle is visible at the right section of the circle’s circumference. The
“turning angle” is the angle that a straight line segment “turns” into the next straight line
segment as the segments pave a 1D curve.

Figure 6-6    Example Surface, Most Coarse Possible (Fraction = 1.0)

Figure 6-7    Example Surface, Fine Resolution (Fraction = 0.03)
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To better visualize the effects of this resolution parameter, Figure 6-9 shows the effects
of both increasing and decreasing the Max Turning Angle parameter from the default value. 

Another option for controling mesh resolution is adding break points to edges. An edge
that is defined by three points will be subdivided by the mesher into more elements than an
edge defined by two points. Likewise, a face that is subdivided will be meshed differently
than a face that is not, even if the subdivisions are in the same plane. Faces of solid geometry
may be subdivided using the imprint command (Modify > Solid Editing > Imprint Edges).
To ensure nodes are created along a certain line or curve on a solids face, create the line or
curve and imprint it on the solid. To ensure a node is created at a specific location, create a
line that ends at the point and imprint that line onto the surface.

Figure 6-8    Example Surface with Hole, Default Resolution (Max Turning Angle = 45)

Figure 6-9    Example Surface with Hole, Max Angle = 90 (Left) and 22.5 (Right)
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6.2.3   Slivers, Cracks, and other Problems in Parts

Numerical inaccuracies and truncations in the geometry engines used to build represen-
tations of complex solid modeling parts are not uncommon. “Slivers,” “cracks,” and other
defects can cause problems for meshers, which cannot assume that such mistakes were
accidental.

Figure 6-10 presents an example of a crack introduced in the previous example. In this

case, the mesher does not fail per se, but rather returns a unusual distribution of element
sizes that should draw the user’s attention toward a possible problem in the underlying part.

Figure 6-10    Irregular Mesh Density Indicates a Possible Problem in the Part
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If the defect is severe enough, the mesher can fail mathematically preventing the mesh
from being drawn at all. If it fails, it will draw red crosses on potential problem areas. Figure
6-11 shows one such failed part, with the blue circle has been added to indicate the location

of the real defect (which would be visible if sufficiently zoomed). 

The red indicators can be cleared by resetting Thermal Desktop graphics ( ).

6.2.4   Generating the FEM Mesh

The bottom two thirds of the form depicted in Figure 6-1 control the generation of
nodes and elements. The middle third (described in Section 6.2.4.1) is used to define thermal
submodels, numbering, initial temperatures, material properties, radiation, contact, insula-
tion, and other thermal properties. The bottom third (described in Section 6.2.4.2) invokes
the generation of the FEM mesh based on the preview (geometric mesh) and on the thermal
properties.

6.2.4.1   Nodes and Properties

Thermal properties may be assigned within the Mesh Controller (middle third of Figure
6-1) independent of the preview mesh, and independent of whether or not the FEM mesh
has yet been generated. In other words, customizations made in these locations are preserved
as long as the Mesh Controller itself is not deleted. Newly created FEM meshes will use
these thermal properties. If a FEM mesh exists and the thermal properties are edited, the
FEM mesh will be updated accordingly.

Edit Node Properties... By default, a new thermal submodel named “Sid” will be
created for each part’s mesh, where id is the TD-assigned designation for the Mesh Controller
(e.g., S99, S1c45, etc.), and the nodes will be numbered starting with 1. The user can alter

Figure 6-11    Mesh Failure Points Indicated in the Part (blue circle has been added)
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these choices, along with the initial temperature of the nodes, using the TD FEM Mesh
Node Properties form (Figure 6-12). These designations will be preserved if either the
preview or the FEM mesh is regenerated as long as the Mesh Controller is not deleted.

Edit Surface Properties... allows the user to set the properties of all the 2D surface
elements that are generated, either from a part that is a surface, or from the surface mesh
generated on the outsides of a solid. This is the same form used for editing triangular or
quadrilateral elements in Thermal Desktop. Optical Properties, Analysis Groups, Conduc-
tion/Capacitance data (including non-displayed thickness) etc. can all be set in this form. If
the FEM mesh has already been generated, then this form edits all of those surfaces. If the
FEM mesh has not yet been generated, or if it has been deleted, then this form specifies the
properties for any newly created surface elements generated from the preview mesh in the
future.

Edit Solid Properties... allows the user to set the properties of all the 3D solid elements
that are generated. This is the same form used for editing solid elements in Thermal Desktop.
This form can be used to set the materials, material orienters, conductor submodels, and
density/conductivity scaling factors. If the FEM mesh has already been created, this form
modifies the parameters of those solid elements. If the solid elements have not yet been
created, or if they have been deleted, then this form specifies the properties for any newly
created elements that will be generated from the preview mesh.

6.2.4.2   Generating FEM Mesh from Preview

Generate TD FEM Mesh from Preview button will create Thermal Desktop nodes
and elements from the preview mesh. These are the network objects that Thermal Desktop
will use for thermal calculations. Note that these FEM objects will be placed on a new layer
whose name is based on the object ID and label of the Mesh Controller. Surfaces are placed
on a layer named “TDFEM_2D_label.id,” and solids are placed on “TDFEM_3D_label.id,”
where label is the optional user-assigned label (Section 6.2.5.1) and id is the TD-designated
Mesh Controller ID (e.g., “714” or “5C4”). Section 6.2.5.2 describes how to use these layers
to easily control the visibility of each component of a TD mesh.

Each TD mesh will also be placed into a unique AutoCAD group named according to
the same scheme used for layers. Up to three such groups can exist for a single Mesh
Controller: one for the nodes (“0D”), one for the surface elements (“2D”) and one for the
solid elements (“3D”), as described in more detail in Section 6.2.5.2. If the label is changed,
corresponding layer and group names are automatically updated.

Figure 6-12    FEM Mesh Node Properties Form
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Delete TD FEM MESH provides a means of deleting a FEM mesh, though this step is
not necessary in order to regenerate a mesh: deletion of the FEM mesh is performed auto-
matically if the preview mesh is regenerated.

Release from Controller allows a generated FEM mesh to become uncoupled from
its Mesh Controller. This is an advanced option that should be used with caution. The
uncoupled FEM mesh can no longer be accessed through this or any other Mesh Controller:
it is now a stand-alone set of FEM elements that must be edited separately. An uncoupled
mesh should be moved into a different layer and AutoCAD group, since otherwise confusion
or conflict can arise if the Mesh Controller is used to regenerate a new and independent
FEM mesh.

One possible use is of this option is to employ the same object to create multiple meshes,
though it is better to start with multiple copies of the underlying part. Another use is to
freeze the configuration of a FEM mesh such that subsequent changes within the Mesh
Controller do not affect it.

Nodes created on TD finite difference surfaces and solids cannot be moved or deleted
directly, they are under the control of the surface or solid. Likewise with a mesh controller.
Nodes cannot be moved or deleted directly by the user, they must be deleted using the
controller, or moved using the controller. (When moving a controller, it is recommended to
move the underlying part simultaneously. Otherwise, if the mesh is regenerated, it will be
placed back at the location of the part.) Individual nodes can be moved or deleted once the
mesh is released from the controller. 

6.2.5   Viewing the Mesh

TDMesh uses an underlying part (CAD surface or solid), a geometric mesh or preview,
and finally the surface and solid FEM elements themselves. Section 6.1 contained sugges-
tions for preparations to avoid excessive time the software spends redrawing meshes and
elements. This section describes how to modify the visibility and display of the generated
objects after they have been created.

6.2.5.1   Controlling the Mesh Display

Set Label... The Mesh Controller label can be optionally defined (or redefined) using
this button on the TD FEM Mesher dialog (Figure 6-1). This label will be used as part of
the layers and AutoCAD group names used to contain the preview mesh, the part, and the
TD FEM elements.

Display Preferences... Using this button on the TD FEM Mesher dialog, the preview
mesh display can be customized using the controls shown on the left side of Figure 6-13.
These options are especially useful for viewing solid geometric meshes. Note that the pre-
view’s visibility can be turned off at the AutoCAD layer level, as described in Section 6.2.5.2.
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6.2.5.2   Accessing and Controlling Visibility of Parts, Previews, and FEM Meshes

If a solid is meshed and both the surfaces and interior portions are used as the basis for
generating FEM meshes, then at least 4 layers and 3 AutoCAD groups will have been
generated automatically. For example, if such a solid were meshed and the resulting Mesh
Controller ID was assigned by Thermal Desktop to be “8BE,” and if the user had assigned
the label name “myblock,” then the following AutoCAD layers and groups would have been
created:

Layers:

TDFEM_PRT_MYBLOCK.8BE ... containing the part (CAD surface, solid)

TDFEM_MC_MYBLOCK.8BE ... containing the Mesh Controller

TDFEM_2D_MYBLOCK.8BE ... containing the 2D (surface) elements

TDFEM_3D_MYBLOCK.8BE ... containing the 3D (solid) elements

Groups: 

TDFEM_0D_MYBLOCK.8BE ... containing the thermal nodes

TDFEM_2D_MYBLOCK.8BE ... containing the 2D (surface) elements

TDFEM_3D_MYBLOCK.8BE ... containing the 3D (solid) elements

The part layer is automatically rendered invisible when the Mesh Controller is invoked
with the tdMesh command (and by having generated a preview). Otherwise, the visibilities
of these layers can be individually controlled using AutoCAD techniques, or they can be
controlled using the TD toolbar options shown at the right of Figure 6-13. For example, a
common choice is to turn off visibility of all 3D solid layers (TD_FEM3D …) so that only
surfaces are visible for a coated 3D model.

AutoCAD groups can also be used to help perform selection operations.

Figure 6-13    Editing Mesh Display, and Controlling Visibility using the Toolbar

TDMesh
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Preview Visibility
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Solid Visibility
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6.2.6   Editing the Mesh using the Mesh Controller

Once a Mesh Controller has been created by generating a preview, it can be accessed
by selecting anywhere on the preview, including the ID (for example, the “1D53” as shown
at the right in Figure 6-5) and editing the object, or by locating the Mesh Controller in the
Model Browser (List->Meshers).

The Mesh Controller will be saved along with the drawing even if no FEM mesh yet
exists, such that this task can be completed later. Also, as described in prior sections, any
of the modeling decisions (e.g., mesh resolution, material properties, etc.) can be revisited
at any time using an existing Mesh Controller. However, some operations will force the
deletion of the FEM mesh (e.g., changing preview mesh resolution), which in turn might
require some customizations (e.g., assignment of heaters, convection, etc.) to be repeated.

6.2.7   Moving the Mesh

To move (using the AutoCAD Move command) a mesh created using TDMesh, the best
practice is to move the part and the Mesh Controller together. The nodes of a TDMesh cannot
be moved away from the Mesh Controller much like a node cannot be seperated from its
TD surface. If the Mesh Controller is moved alone, then if the mesh is regenerated the mesh
will be realigned with the part.

6.2.8   Copying the Mesh

A mesh can be copied by selecting the Mesh Controller alone using either Ctrl-C/Ctrl-
V or the AutoCAD Copy command. A copy of the part, preview and mesh will be placed
wherever the user selects. New layers (as described in Section 6.2.5.2) will also be created.

6.2.9   Attaching the Mesh to an Articulator

Meshes generated using TDMesh can be attached to articulators (assemblies or trackers).
The Mesh Controller is the only mesher entity (part, preview or mesh) that must be attached
to an articulator for the mesh to move with the articulator. Attaching only the nodes and
elements or only the part will not cause the mesh to move with the articulator. A best practice,
however, would be to attach both the Mesh Controller and the part to the articulator. This
ensures that the mesh remains aligned appropriately with the articulator.. If only the Mesh
Controller were attached to the articulator and the articulator repositioned, then regenerating
the mesh from the preview would cause the mesh to realign with the part even though the
mesh would still be attached to the articulator.
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6.3 TDMesh Extrude

For meshing arbitrary solid CAD parts, TDMesh described in Section 6.2 is applicable.
Arbitrary CAD surfaces can also be meshed, and if they are sufficiently thin, they can be
modeled as planar elements whose thickness (and perhaps insulation properties) can be
assigned for thermal response (even though the thickness and insulation are not depicted
geometrically).

For objects that are thick enough or thermally resistant enough such that through-thick-
ness temperature gradients are important, or when a definite geometric depiction of their
overall thickness is required, the TD Mesh Extrude option may be applicable.

Many types of solids are most efficiently formed by extruding an arbitrary CAD surface
through a length, with the mesh generated on that original surface also extruded at the same
time.

The resulting mesh is no longer a tri-tet mesh. Figure 6-14 shows a pentagon (the red
base part) that has been meshed in the original plane, then extruded into three solid layers.
The same triangular surface mesh exists at all four planes between these three layers, but at
the outsides the surface elements are quadrilaterals, and pentahedral elements (extruded
triangles) are used to represent the 3D elements.

In addition to using higher-level finite elements, an extruded mesh has several important
advantages over a 3D tetrahedral mesh that would result if the full TDMesh had been applied
to the final (extruded) solid. All of these advantages relate to the fact that the key surfaces
in the resulting mesh can be generated and addressed separately, which greatly facilitates
application of boundary conditions that vary according to the face. This capability is con-
trasted with that of the full TDMesh, which can only generate and address all the surfaces

Figure 6-14    Example Extrusion: Pentagon Extruded into 3 Layers
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as a single entity. In other words, the full TDMesh recognizes only one outer surface, and
it can make no distinctions based on “faces” (which might not even exist, as is true in the
case of a sphere).

The usage of the TD Mesh Extruder is almost identical to that of the full TDMesh
explained in Section 6.2, so this section will only highlight important differences.

To use the mesh extruder, type tdmeshextrude in the command prompt, then highlight
an AutoCAD region or appropriate CAD surface. Figure 6-15 shows the resulting form.
Note that the base, end, and side surfaces can be edited separately. “Base” refers to the
surface formed by the original CAD part (surface), “end” refers to the analogous surface
formed at the far end of the extrusion (opposite the base, and perpendicular to the direction
of extrusion), and “side” collectively refers to all other surfaces (parallel to the direction of
extrusion).

Selecting Generate Preview... invokes the preview parameter options shown in Figure
6-16. This form is similar that of the full 3D mesher in terms of mesh resolution adjustments,
but it also contains fields for defining the distance to extrude in model units (can be positive
or negative), and the number of layers to employ. The number of layers can be specified to
be broken down in equal size layers, or a parametric list of boundaries may be input. The
parametric distance is 0 at the base and 1 at the end of the extrusion. Intermediate positions
are specified as number between 0 and 1. Since the first and last boundaries will always
exist, they are not input. Only the intermediate layer boundary locations need to be supplied. 

Figure 6-15    TD Mesh Extruder and Revolver Form

Base, end, and side sur-
faces can be customized 
separately
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New elements will be extruded in a direction normal to the surface elements. “Layers”
refers to the number of solid sections. The total number of copies of the base surface mesh,
including the original base mesh, will be one plus the number of solid layers requested.

These two values can be redefined at any time, but doing so will force a regeneration
of the preview mesh, and this action will in turn cause the deletion of any FEM meshes that
have been created based on those previews; the same effects that are caused by changing
mesh resolution within the base part.

This form is similar that of the full 3D mesher in terms of mesh resolution adjustments,
but it differs in that the user can selectively omit the preview mesh for any or all of the three
surfaces (base, end, side) associated with the extrusion. This means the mesh extruder can
create open shells (e.g., sides only) and other objects that cannot be created using the full
TDMesh.

For extrusion and revolving operations, an option exists to give each copy of the base
mesh layer the same node IDs. For an extrusion, this would make a three dimensional thick
finite element mesh, but the resulting network of nodes and conductors would be two di-
mensional in SINDA/FLUINT. This may be a convenient way of modeling thick parts that
perhaps must attach to other parts on both sides, but it is desired to keep only a two dimen-
sional resolution. Likewise for revolved parts, Using the same node ID’s on each layer
simulates a two dimensional, radially symmetric part. Select the Repeat Base ID’s for 2D
Symmetry option on the Mesh Node Properties form, as shown in Figure 6-17.

Figure 6-16    TD Mesh Extruder Parameters

Base, end, and side sur-
faces can be generated 
or omitted separately
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6.4 TDMesh Revolve

For meshing arbitrary solid CAD parts, TDMesh described in Section 6.2 is applicable.
However, many types of solids can be formed by revolving an arbitrary CAD surface around
an axis, with the mesh generated on that original surface also revolved along the arc.

The resulting mesh is no longer a tri-tet mesh. Figure 6-18 shows a rectangle with three
holes (the red base part) that has been meshed in the original plane, then revolved 90 degrees
into six solid layers subtending 15 degrees each. The same triangular surface mesh exists
at all seven planes between these six solid layers, but the sides the surface elements are
quadrilaterals, and pentahedral elements (extruded triangles) are used for the solid portions
of the model.2

In addition to using higher-level finite elements, a revolved mesh has several important
advantages over a 3D tetrahedral mesh that would result if the full TDMesh had been applied
to the final (revolved) solid. All of these advantages relate to the fact that the key surfaces
in the resulting mesh can be addressed separately, which greatly facilitates application of
boundary conditions that vary according to the face. This capability is contrasted with that
of the full TDMesh, which can only generate and address all the surfaces as a single entity,
making no distinctions based on “faces” (which might not even exist, as in the example of
a sphere). In addition, revolving a base mesh can model the same solid geometry with less
elements than if it were meshed with tetrahedrons.

The usage of the TD Mesh Revolver is almost identical to that of the full TDMesh
explained in Section 6.2, so this section will only highlight important differences.

To use the mesh revolver, type tdmeshrevolve in the command prompt, then select an
AutoCAD region or appropriate surface, and then select an axis of revolution. Figure 6-15
shows the resulting form (which is identical to that of the mesh extruder described in Section
6.3). Note that the base, end, and side surfaces can be edited separately. “Base” refers to the

2 Revolving about an axis that touches one side of the part, or that is coincident with it, is legal. Such a revolution
results in some side surface elements that may not be quadrilaterals, and in some solid elements that may not be
pentahedrons.

Figure 6-17    Option for Creating a 2D Symmetric Part When Extruding or Revolving
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surface formed by the original part, “end” refers to the analogous surface formed at the far
end of the revolution (in a plane containing the axis of revolution), and “side” collectively
refers to all other surfaces.3

Selecting Generate Preview... invokes the preview parameter options shown in Figure
6-19. This form is similar that of the full 3D mesher in terms of mesh resolution adjustments,
but it also contains fields for defining the number of degrees to revolve (can be positive or
negative), and the number of layers to employ. “Layers” refers to solid sections, such that
the number of copies of the base surface mesh, including the original base surface mesh,
will be one plus the number of solid layers. For revolutions equal to 360 degrees, the base
and end meshes are automatically merged to form a continuous part.

These two values can be redefined at any time, but doing so will force a regeneration
of the preview mesh, and this will in turn cause the deletion of any FEM meshes that have
been created based on those previews; the same effects that are caused by changing mesh
resolution within the base part.

The user can selectively omit the preview mesh for any or all of the three surfaces (base,
end, side) associated with the revolved part. This means the mesh revolver can create open
shells (e.g., sides only) and other objects that cannot be created using the full TDMesh.

3 The “side” includes the internal toroidal shapes in the example shown in Figure 6-18: internal surfaces are
also considered “sides.”

Figure 6-18    Example Revolution: 3-holed Rectangle, 90 degrees with 6 layers
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If a full 360 degree revolution is performed, then the first and last surfaces are coincident.
Only one set of nodes will be generated at this location, and the user should not activate the
properties of the base and end surfaces (e.g., radiation, insulation): only the side surface is
now applicable.

The node ID’s used for the base layer may be repeated for each copy of the base layer
by checking the Repeat Base ID’s for 2D Symmetry option on the Mesh Node Prop-
erties form, as shown in Figure 6-17. The essentially creates a 3D representation of a 2D
radially symmetric configuration. Node and conductor data for each layer is combined
together before being sent to SINDA/FLUINT for analysis, and is computationally a 2D
radial symmetric problem inside of SINDA/FLUINT. This will improve computational ef-
ficiency where such symmetry is applicable.

Figure 6-19    TD Mesh Revolver Parameters

Base, end, and side sur-
faces can be generated 
or omitted separately
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